Assessment in Junior
Physics Laboratory




Abstract

* My institution began a new assessment plan for the physics
major about 18 months ago.

* This requires the assessment of the Junior Lab students’:
1. communication (written, graphical, verbal)
2. their ability to work in a team
3. the evaluation of a design lab

| will share the rubrics that | have borrowed, modified, and
created to implement this assessment the past two
semesters.

You don’t need to take notes of rubric webpages as | have
printed the reference page for you to take with you.




What Items to Assess?

AP .. JIRENDS

of Physics STATISTICAL RESEARCH CENTER  www.aip.org/statistics

* We looked to

AIP select skills
to assess as
these are valued
by employers.?

We chose more
than these for our
overall assessment
of major...I am
only talking about
Jr Lab assessment
today.

Skills Used Regularly

Physics Bachelor’s in the Private Sector, Class of 2007

Employment in Employment in Computer
Engineering Science or Information Tech.

Solve Technical Problems
Work on a Team
Technical Writing
Knowledge of Phys. or Ast.
Perform Quality Control

Manage Projects

Work with Customers
Use Specialized Equip.
Design & Development
Programming

Advanced Math
Simulation or Modeling
Manage People
Computer Administration
Manage Budgets

75 0
Percent

Percentages represent the proportion of physics bachelor's who chose "daily", "weekly,"
or "monthly" on a four-point scale that also included "never or rarely."

Source: AP Statistical Research Center, Initial Employment Survey Class of 2007.

Fall 2010




Skill 1. Communication

 Written communication is important in writing the abstract,
introducing the research, explaining the theory behind the
experiment, providing adequate details of the experimental
design, describing the findings and reasons for error, and
developing a coherent conclusion.

 Graphical communication involves the description and
explanation of the characteristics of graphs made during an
experiment. It also involves proper format of tables and
integrating the findings obtained in the graph into the results
of the experiment. We found our students needed more skill
in describing the graph, they wanted to simply display it and
go on without ever using words to describe the graph.

* Verbal communication includes speaking publically about

each of the above items above in a way that reaches the
audience.
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Rubrics on LabWrite

Labwrite rubrics are on their site.

[ <> ] + | 8 www.ncsu.edu/labwrite/instructors/excelsheets.htm| ¢
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Grading Lab Reports-Grading Sheets I LabCheck Evaluation Guide-Printable Version
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650 bwrite improving lab reports

Contact Help

[A teacher’s guide to using LabWrite in your laboratory cluss'

Grading Rubric

Click on the grading rubric you need to grade a particular lab and save it to your computer. Standard labs are typical, experimental labs driven by hypotheses. Descriptive labs are are not driven by hypotheses, e.g., observational labs or labs about
procedure. Designing labs is the category for labs in which students design their own experiments. Consult "How to use the Excel grading rubric" found below for explanations of the fixed/modifiable scale grading sheets.

Excel Grading Sheets

Standard Labs l Modifiable Scale [

Fixed Scale ‘

Modifiable Scale

Descriptive Labs |

Fixed Scale ‘

Designing Labs Modifiable Scale

Fixed Scale ‘

How to use the Excel grading rubric:

The "fixed scale" grading sheet is based on a "poor" to "excellent” 5-point scale with the points on the scale equal to 0.0, 0.25, 0.5, 0.75, and 1.0, respectively. These values are locked and are not changeable without unlocking the worksheet. You
may only change the point values for each section of the lab report (see figure 1 below).

The "modifiable scale” grading sheet is based on a traditional "F* through "A" scale with numeric values between 0 and 100 assigned to points on the 5-point scale by the instructor. The cells showing the numeric values are below the letter grades
and are the cells used to calculate the score for each of the criteria. These cells are unlocked and modifiable by the instructor (figure 2 below).

If you do not want students to see the actual numeric value assigned to each of the letter grades in a printout, you can hide them by doing the following:

& Choose Tools>Protection>Unprotect Sheet....
# Highlight the cells holding the numeric values underneath the letter grades.
® Choose Format>Cells.... Click on the Font tab and choose a white

font color (the same color as the background of the worksheet.
® Alternately, you can choose the Font Color tool from the Formatting toolbar.
* Re-protect the sheet by choosing Tools>Protection>Protect Sheet....

With the font the same color as the background, it will no longer

show on a printout.

Note that the Excel rubrics are Excel workbooks with three worksheets each (accessed by the tabs at the bottom left of the workbook file, best seen if the window is maximized):




Jr Lab Report Writer:

Lab Partners:

Section Points

N

HH

20

15

10

10

100

Title
Describes lab content concisely, adequately, appropriately

Abstract
Conveys a sense of the full report concisely and effectively

Introduction

Successfully establishes the scientific concept of the lab
Effectively presents the objectives and purpose of the lab
States hypothesis and provides logical reasoning for it

Methods
Gives enough details to allow for replication of procedure

Results

Opens with effective statement of overall findings
Presents visuals clearly, legibly, and accurately

Presents verbal findings clearly and with sufficient support
Successfully integrates verbal and visual representations

Discussion

Opens with effective statement of support of hypothesis
Backs up statement with reference to appropriate findings
Provides sufficient and logical explanation for the statement
Sufficiently addresses other issues pertinent to lab(error)

Conclusion

Convincingly describes what has been learned in the lab
this is where extension problems are graded!
Presentation

Citations and references adhere to proper format

Format of tables and figures is correct

Report is written in scientific style: clear and to the point
Grammar and spelling are correct

Overall aims of the report: the student...

Has successfully learned what the lab is designed to teach
Demonstrates clear and thoughtful scientific inquiry
Accurately measures and analyzes data for lab findings

Poor Excellent
F D C B A
Section
o 69 77 85 93 Scores
0.93
[ [ 1 X
2.76
[ X[ |
8.66
X
X
X
9.30
[ [ 1 X
18.60
X
X
X
X
18.20
X
X
X
X
10.35
[ Ix] |
7.44
X
X
X
9.30
X
X
X

Points Earned

Total Possible Points

Percentage

85.54
93




Written Communication
rubric results

* All but 1 student this year (9 in fall, 8 in spring) knew what | wanted
on labs because they read the rubric.

* One however was not so happy on his evaluation of grading:

| loved this lab, but | had some trouble getting everything that
she wanted in the lab writeups. | did improve on the next bundle of
writeups, but | still had some learning to do! By the end of the course |
understood what all needed to be on the writeups. But now I'm looking
at a Cright now, if | do good on the final | might be able to pull a B. |
was a little bitter about the grading of this class, but everyone else did
fantastic! I'm just dumb I guess....

* It took me about 3 hours to grade 8 or 9 students lab reports using
this rubric. For me...this assessment cost me time.

* My evaluation on course was 4.6/5 (bit lower than my normal |
believe because they thought the course was too much work).




Lab Scores Using Rubric

JR Physics Lab - Dr. K. Williams F13

Teaml|Hspect| FHz [Light| Team2 |Thalf| e/m h Team3| VP [Gamma|Bungee| Team ([PeerEval|l Design | SUM %

# 36 100 100 100 36 100 100 100 36 100 100 100 36 30 70 1044 | 100
12 36 90 91 36 94 89 97 36 90 92 96 36 30 67 980 | 93.87
18 33 91 89 36 98 96 94 34 85 95 95 36 30 56 968 | 92.72
7 26 87 59 30 96 96 79 36 90 94 93 36 30 61 913 | 87.45
9 30 80 94 36 88 85 80 35 93 93 93 36 30 61 934 | 89.46
3 35 89 91 98 98 99 0 35 88 95 90 30 30 61 939 | 89.94
2 32 96 95 90 36 98 96 96 36 93 93 36 30 61 988 | 94.64
11 33 89 96 90 32 82 86 36 78 81 95 36 30 67 931 | 89.18
1 31 93 81 36 92 95 94 36 89 89 95 36 30 56 953 | 91.28
36 95 97 91 36 98 98 92 36 92 95 36 30 67 999 | 95.69

Junior Physics Lab -Sp14 Williams

S#  |[Teaml|Hspect| Light [ FHz | TEAM2 e/m t1/2 Planck Team3 [ mu| T | Bungee [ Team4| PeerEval | Design| SUM| %
0 36 100 100 100 36 100 100 100 36 100| O 100 36 30 70 (1044| 100
17 34.5 0 75 88 36 58 73 94 36 51| 80 93 36 28 43.8 | 826 | 79.15

4 34.5 92 98 100 35 96 96 96 36 0 |91 93 36 30 58.3 | 992 95
7 36 89 79 95 36 0 83 87 36 88 | 88 93 36 30 61.2 | 937 | 89.77
13 35.5 96 94 99 31 93 96 98 33 95| O 93 36 27 43.8 | 970 | 92.94
2 33.5 91 90 95 31 98 0 96 36 95 | 89 93 36 29 58.3 | 971 | 92.99
14 36 88 84 96 36 97 94 0 36 89 | 85 93 36 30 58.3 | 958 | 91.79
1 36 96 0 84 35 96 98 96 36 95 | 87 93 36 30 61.2 | 979 | 93.79
5 36 0 89 96 36 95 90 94 36 90 | 85 93 36 29 43.8 | 949 | 90.88




Graphical Communication

* | used section on Results and Presentation from the Written
Comm. Labwrite rubric for graphical skill assessment for

Franck Hertz lab..

Results

Opens with effective statement of overall findings
Presents visuals clearly, legibly, and accurately

Presents verbal findings clearly and with sufficient support
Successfully integrates verbal and visual representations

Presentation

Citations and references adhere to proper format

Format of tables and figures is correct

Report is written in scientific style: clear and to the point
Grammar and spelling are correct

Overall aims of the report: the student...

Has successfully learned what the lab is designed to teach
Demonstrates clear and thoughtful scientific inquiry
Accurately measures and analyzes data for lab findings

18.60
= :
X
X
__________________ L N . T
7.28 |
X UU
X
X
x
9.30
= 4
X
X




Verbal Communication

e Students did a design/research project the last 2-3 wks.
* Students completed a powerpoint and gave the presentation to
the class for their final exam.

* Their peers completed this sheet and the average was their verbal
Comm. score. (minus item2 and 6).

 So this was a one shot measurement of verbal communication skill.

JUNIOR LAB PEER GRADING SHEETS SP2014 - DO NOT GRADE YOURSELF. .

Strongly Agree | Agree | Disagree |Strongly Disagree| Not Apply SUM
5 4 2 1 3 XXX3000K

Can hear presentation
Can see presentation
Paper given professionally
Explained well

Research Complete

Work Shared

Overall Pt Score




Skill 2: Teamwork

Several years ago, | encountered a student that did not want
to work with others. The students did not want to work with
this student either.

So.... | put the students in groups so they each had to work
with this student.

Each set of 3 labs the students worked together, then next set
of 3 labs they would work with others.

At the end of the 3 labs each student completed this rubric
and turned it in to me directly.

The teamwork rubric came from the U of Wisc/Stout* with
few modifications.




Teamwork

Rubric

person evaluated:

evaluator:

Category

Exemplary (3 pts)

Proficient (2 pts)

Somewhat proficient (1 pts)

Unsatisfactory (0 pts)

POINTS
(36 pts max.)

1. Focus on the
task.

Stays on task all of the
time without reminders.

Stays on task most of the
time. Group members can
count on this person.

Stays on task some of the time. Group
members must sometimes remind this
person to do the work.

Hardly ever stays on task. Lets
others do the work.

2. Extent to which
works together.

A true team member who
works hard and helps
others in the group.

A strong group member
who tries hard!

Sometimes an active group member,
but needs to try harder.

Sometimes chooses not to
help out, and does not
complete tasks.

3. Work meeting
habits.

Is on time for meetings,
turns in all work when it
is due.

Usually on time for
meetings, turns in most
work when it is due.

Sometimes late for meetings, often
turns in work late.

Late for all or most meetings,
and late turning in work.

4. Completion
habits.

Completes assigned tasks
and does not depend on
others to do the work.

Completes most assigned
tasks.

Does not follow through on most tasks
and sometimes counts on others to do
the work

Does not complete tasks.
Depends on others to do all of
the work.

5.
Attitude/Behavior
while Listening,

Talking, Discussing

Respectfully listens,
discusses, asks questions
and helps direct the
group in solving
problems.

Respectfully listens,
discusses and asks
questions.

Has trouble listening with respect, and
takes over discussions without letting
other people have a turn.

Does not listen with respect,
argues with teammates, and
does not consider other ideas.
Blocks group from reaching
agreement.

6. Research and
Information-
Sharing

Gathers information and
shares useful ideas for
discussions. All
information fits the
group’s goals

Usually provides useful
information and ideas for
discussion.

Sometimes provides useful
information and ideas for discussion.

Almost never provides useful
information or ideas for
discussion.

7. Problem-solving

Actively seeks and
suggests solutions to
problems.

Improves on solutions
suggested by other group
members.

Does not offer solutions, but is willing
to try solutions suggested by other
group members.

Does not try to solve problems
or help others solve problems.

8. Goal completion

Works to complete all
group goals.

Usually helps to complete
group goals.

Occasionally helps to complete group
goals.

Does not work well with
others and shows no interest
in completing group goals.

9. Attitude about
task.

Always has a positive
attitude about the task(s)
and the work of others

Usually has a positive
attitude about the task(s)
and the work of others.

Sometimes makes fun of the task(s) or
the work of other group members.

Often makes fun of others’
work and has a negative
attitude.

10. Time
distribution on
task.

All team members
contributed equally to
the finished project.

Assisted group/partner in
the finished project.

Finished individual task but did not
assist group/partner during the
project.

Contributed little to the group
effort during the project.

11. Overall
participation.

Performed all duties of
assigned team role and
contributed knowledge,
opinions, and skills to
share with the team.
Always did the assigned
work.

Performed nearly all duties
of assigned team role and
contributed knowledge,
opinions, and skills to share
with the team. Completed
most of the assigned work.

Performed a few duties of assigned
team role and contributed a small
amount of knowledge, opinions, and
skills to share with the team.
Completed some of the assigned work.

Did not perform any duties of
assigned team role and did
not contribute knowledge,
opinions or skills to share with
the team. Relied on others to
do the work.

12. Grade from
Instructor.

Rubric Modified by Dr Williams from: http://www?2.uwstout.edu/content/profdev/rubrics/elemteamworkrubric.html




Assigned Design lab
-Final Assessment of Teamwork

Each individual after doing all of the ‘regular labs” must be a
team (consulting group) for a rather odd assigned lab.

Each group must meet and work on a part of this project.

All groups meet and decide how to solve the problem. The
work that group A must do first is decided.

Group A does work that day on it and then all 3 groups meet at
the end of the day to decide what must be done next. All
groups have input.

The next week group B does this work. At the end they all meet
and decide what group C must do.

Then they must work together to do the final report.

At the end they turn in the report and turn in TEAMWORK forms
on each other.




Skill 3: Design Lab

* After the entire class “team” project, | make them pick
something to research. 2-4 students may work together.

* They must design the lab, gather the equipment and do the
experiment and write it up on a powerpoint as if they were
presenting at a conference.

* The rubric | chose to assess the design of their [ab was from
the American Association of Colleges and Universities: The
Inquiry and Analysis Value Rubric.”




Design Rubic

INQUIRY AND ANALYSIS VALUE RUBRIC

Jfor more information, please contact value@aacu.org

Definition

Association

A A of Amerian
Colleges and
Universities

Inquiry is the ability to know when there is a need for information, to be able to identify, locate, evaluate, and effectively and responsibly use and share that information for the problem at hand. — The

National Forum on Information Literacy

Eualuators are encouraged 1o assign a ero 1o any work sample or collection of work that does not meet benchmark (cell one) level performance.

Existing Knowledge, Research,
and/or Views

potentially significant yet previously less-
explored aspects of the topic.
Synthesizes in-depth information from
relevant sources representing various
points of view/approaches.

appropriately addresses relevant aspects
of the topic.

Presents in-depth information from
relevant sources representing various
points of view/approaches.

focused and leaves out relevant aspects
of the topic.

Presents information from relevant
sources representing limited points of
view/approaches.

Capstone Milestones Benchmark
4 3 2 1
Topic selection Identifies a creative, focused, and Identifies a focused and Identifies a topic that while Identifies a topic that is far too general
manageable topic that addresses manageable/doable topic that manageable/doable, is too narrowly and wide-ranging as to be manageable

and doable.

Presents information from irrelevant
sources representing limited points of
view/approaches.

Design Process

All elements of the methodology or
theoretical framework are skillfully
developed. Appropriate methodology or
theoretical frameworks may be
synthesized from across disciplines or
from relevant subdisciplines.

Critical elements of the methodology or
theoretical framework are appropriately
developed, however, more subtle
elements are ignored or unaccounted
for.

Critical elements of the methodology or
theoretical framework are missing,
incorrectly developed, or unfocused.

Inquiry design demonstrates a
misunderstanding of the methodology
or theoretical framework.

extrapolation from the inquiry findings.

inquiry findings. The conclusion arises
specifically from and responds
specifically to the inquiry findings.

it is so general, also applies beyond the
scope of the inquiry findings.

Analysis Organizes and synthesizes evidence to | Organizes evidence to reveal important |Organizes evidence, but the Lists evidence, but it is not organized
reveal insightful patterns, differences, or | patterns, differences, or similarities organization is not effective in revealing |and/or is unrelated to focus.
similarities related to focus. related to focus. important patterns, differences, or

similarities.
Conclusions States a conclusion that is a logical States a conclusion focused solely on the | States a general conclusion that, because | States an ambiguous, illogical, or

unsupportable conclusion from inquiry
findings.

Limitations and Implications

Insightfully discusses in detail relevant
and supported limitations and
implications.

Discusses relevant and supported
limitations and implications.

Presents relevant and supported
limitations and implications.

Presents limitations and implications,
but they are possibly irrelevant and
unsupported.

| complete this on each group for their Design grade worth 70 pts.
Their score on the verbal assessment is 30 pts of their final 100.




Jr Lab Assessment Conclusions

Doing all this assessment in only one lab is probably not optimal. It
should be used in all upper level labs.

Teaching Jr Lab both semesters to 9 and 8 students was a great
deal of work using the rubrics while teaching a load of 4-5 other
courses. | feel we do have a good assessment and the

administration seems happy.

| do feel nearly all students know how to write research quality
papers as a result. Some did present research after more work.

Perhaps one day | will merge several of these rubrics into one
better one.

The students do see the write-ups as less ‘objective’ with the lab
rubric, much much less arguing for more points as they can see
what they are missing with my comments and the lab rubric.




Information

* | have printed my references for the
rubrics if you would like to take one.

* My contact info is kwillims@mac.com
(no ‘a@’)
or kwilliams@ecok.edu

Thank you!
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